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Important notices 

Intended use 
microQuark is an electrical medical device designed to perform 
pulmonary function tests. It is to be used by physicians or by 
trained personnel on a physician responsibility. 
Caution: Federal law restricts this device to sale by or on the 
order of a physician. 
This equipment has been conceived with the aim of providing an 
auxiliary instrument  allowing: 
• the formulation of lung pathology diagnosis; 
• important studies concerning human physiology; 
• the collection of important information in sport medicine. 
No responsibility attaches COSMED Srl for any accident 
happened after a wrong use of the device, such as: 
• use by non qualified people; 
• non respect of the device intended use; 
• non respect of the hereunder reported precautions and 

instructions. 

Warnings 
The device, the program algorithms and the presentation of 
measured data have been developed according to the 
specifications of ATS (American Thoracic Society) and ERS 
(European Respiratory Society). Other international references 
have been followed when these were not available. All 
bibliography references are reported in Appendix. 
The present handbook has been developed with respect of the 
European Medical Device Directive requirements which sort 
microQuark within Class II a. 
It is recommended to read carefully the following precautions 
before putting the device into operation. 
The precautions reported below are of fundamental importance to 
assure the safety of all COSMED equipment users. 
1. This user manual is to be considered as a part of the medical 

device and should always be kept on hand. 
2. Safety, measure accuracy and precision can be assured only: 
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 • using the accessories described in the manual or given 
with the device. Actually non recommended accessories can 
affect safety unfavourable. Before using non recommended 
accessories it is necessary to get in touch with the 
manufacturer; 

 • ordinary equipment maintenance, inspections, 
disinfection and cleaning are performed in the way and with 
the frequency described; 

 • any modification or fixing is carried out by qualified 
personnel; 

 • the environmental conditions and the electrical plants 
where the device operates are in compliance with the 
specifications of the manual and the present regulations 
concerning electrical plants. In particular grounding 
reliability and leakage current suppression can only be 
assured when the device three – wire receptacle is connected 
to a yellow - green return connected to earth ground. 
Attempting to defeat the proper connection of the ground 
wire is dangerous for users and equipment. 

3. Before powering the system, check the power cables and the 
plugs. Damaged electrical parts must be replaced 
immediately by authorised personnel. 

4. Cleaning residue, particulates, and other contaminates 
(including pieces of torn or broken components) in the 
breathing circuit pose a safety risk to the patient during 
testing procedures. Aspiration of contaminates can 
potentially be life-threatening. You must follow all the 
cleaning procedures in System Maintenance, and you must 
thoroughly inspect the components after cleaning and before 
each patient test. 

5. This device is not suitable for use in presence of flammable 
anaesthetics. It is not an AP nor an APG device (according to 
the EN 60 601-1 definitions). 

6. Keep the device away from heat and flame source, 
flammable or inflammable liquids or gases and explosive 
atmospheres. 

7. In accordance with their intended use microQuark is not to 
be handled together with other medical devices unless it is 
clearly declared by the manufacturer itself. 
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8. It is recommended to use a computer with electromagnetic 
compatibility CE marking and with low radiation emission 
displays. 

9. It is necessary to make the PC, connected to the  microQuark, 
compliant with EN 60601-1 by means of an isolation 
transformer.  

10. Graphical symbols used in accordance to present 
specifications are described here below: 

 Equipment type B (EN60601-1) 

 Danger: high temperature 

 OFF 

 ON 

 Protective earth ground 

 Alternating current 
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Contraindication 

The physical strain to execute the respiratory manoeuvre is 
contraindicated in case of some symptoms or pathology. The 
following list is not complete and must be considered as a piece 
of mere information. 

Contraindications for the Spirometer tests 

Absolute contraindications 

For FVC, VC and MVV tests: 
• Post-operating state from thoracic surgery 
For FVC tests: 
• Severe instability of the airways (such as a destructive 

bronchial emphysema) 
• Bronchial non-specific marked hypersensitivity 
• Serious problems for the gas exchange (total or partial 

respiratory insufficiency) 

Relative contraindications 

For FVC tests: 
• spontaneous post-pneumothorax state 
• arterial-venous aneurysm 
• strong arterial hypertension 
• pregnancy with complications at the 3rd month. 
For MVV test: 
• hyperventilation syndrome 

Contraindications for Bronchial provocation tests 
The bronchial provocation tests must be executed according to 
the doctor’s discretion. There are not data that reveal specific 
contraindication for the bronchial provocation test through 
inhalation. 
The modern standard processes have been revealing secure in 
several clinical studies. However it is recommendable to respect 
the following contraindications: 
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Absolute contraindications 

• Serious bronchial obstruction (FEV1 in adults) 
• Recent myocardium infarct 
• Recent vascular-cerebral accident 
• Known arterial aneurysm 
• Incapacity for understanding the provocation test procedures 

and its implications. 

Relative contraindications 

• Bronchial obstruction caused by the respiratory manoeuvre. 
• Moderate or serious bronchial obstruction. For ex. Predicted 

value FEV1 less than 1.51 in men and predicted value FEV1 
in women less than 1.21. 

• Recent infection in the superior air tracts 
• During the asthmatic re-acuting 
• Hypertension 
• Pregnancy 
• A pharmacology treatment epilepsy 
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Environmental condition of use 

COSMED units have been conceived for operating in medically 
utilised rooms without potential explosion hazards. 
The units should not be installed in vicinity of x-ray equipment, 
motors or transformers with high installed power rating since 
electric or magnetic interferences may falsify the result of 
measurements or make them impossible. Due to this the vicinity 
of power lines is to be avoided as well. 
Cosmed equipment are not AP not APG devices (according to 
EN 60601-1): they are not suitable for use in presence of 
flammable anaesthetic mixtures with air, oxygen or nitrogen 
protoxide. 
If not otherwise stated in the shipping documents, Cosmed 
equipment have been conceived for operating under normal 
environmental temperatures and conditions [IEC 601-1(1988)/EN 
60 601-1 (1990)]. 
• Temperature range 10°C (50°F) and 40°C (104°F). 
• Relative humidity range 20% to 80% 
• Atmospheric Pressure range 700 to 1060 mBar 
• Avoid to use it in presence of noxious fumes or dusty 

environment and near heat sources. 
• Do not place near heat sources. 
• Cardiopulmonary resuscitation emergency equipment 

accessible. 
• Adequate floor space to assure access to the patient during 

exercise testing. 
• Adequate ventilation in the room. 
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Safety and conformity 

Safety 

IEC 601-1 (1988) /EN 60 601-1 (1990); 
Find reported below  the complete classification of the device: 
• Class I type B device 
• Protection against water penetration: IP00, ordinary 

equipment unprotected against water penetration 
• Non sterile device 
• Device not suitable in the presence of flammable 

anaesthetics; 
• Continuous functioning equipment; 

EMC 

The system meets the EMC Directive 89/336 
EN 60601-1-2 
EN 55011 Class B (emission), IEC 1000-4-2, IEC 1000-4-3, IEC 
1000-4-4 

Quality Assurance 

UNI ISO 9001 (Registration n° 387 Cermet) 

Medical Device Directive (CE mark) 

MDD 93/42/EEC (Notified Body 0476). 
Class IIa 
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Keynotes 

Here are the keynotes used to make the manual easier to read. 

Typographic keynotes 
These are the typographic keynotes used in the manual. 

Style Description 

Bold indicates a control or a key to be pressed. 
 

“Italic” indicates a messages shown by the firmware. 

Graphic keynotes 
These are the graphic keynotes used in the manual. 

Illustration Description 

 shows the button to click in the software to 
activate the related feature. 
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Systems Overview 

microQuark is an instrument designed for lung function 
screening; the core of the system is the “intelligent” flowmeter 
that, connected through the serial port (RS232), turns any 
Personal Computer (laptop or desktop) in a complete spirometric 
lab. 
The system is composed by the turbine flowmeter, the 
measurement and data elaboration device (lightweight and 
ergonomic), the communication cable and by the Software pack. 
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Before starting 

Before operating the microQuark system we strongly recommend 
to check the equipment and register you as a customer. 

Checking the packing contents 
Make sure that the package contains the items listed below. In 
case of missing or damaged parts, please contact Cosmed 
technical assistance. 

microQuark standard packaging 

Code  Qty Description 

C00960-01-04 1 microQuark unit 
 

C02235-01-05 1 Turbine 
 

A 662 100 001 2 Nose clips 
 

C01739-02-35 1 PC Software 
 

C00137-01-20 20 Paediatric paper mouthpieces 
 

C00136-01-20 20 Adult paper mouthpieces 
 

C00063-01-20 1 Conic mouthpiece 
 

C00214-01-20 1 Paediatric adapter 
 

A 362 300 004 1 Serial cable RS232 USB Power 
 

C00067-02-94 1 Registration card 
 

C02268-02-91 1 User manual 
 

C01999-02-DC 1 Conformity declaration 
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Warranty registration 

Before using the system, please take a moment to fill in the 
registration form and the warranty and return them to COSMED, 
by doing this you are eligible to the customers assistance service. 
For further information, please refer to the enclosed registration 
and warranty form. If the form is not enclosed in the packaging, 
please contact directly COSMED. 

Register the product via software 

Together with the PC software, a registration software is 
supplied. With this software it is possible to fill in an electronic 
form with the customer information. 
1. To run the software, double click on the icon Registration or 

select Registration… from ? menu. 
2. Type the requested information and click Send… to send the 

form via e-mail to COSMED. 

How to contact COSMED 

For any information you may need, please contact the 
manufacturer directly at the following address: 
COSMED S.r.l. 
Via dei Piani di Monte Savello, 37 
P.O. Box n. 3 
00040 - Pavona di Albano 
Rome - ITALY 
Voice: +39 (06) 931.5492 
Fax: +39 (06) 931.4580 
email: customersupport@cosmed.it 
Internet: http: //www.cosmed.it 

Complain, feedback and suggestions 

If you have any complain, feedback information or suggestion, 
please inform us at complain@cosmed.it. 



 

 Chapter 1 - Getting started - 19 

PC configuration required 

• Pentium 133 MHz. 
• Windows 95, 98, XP. 
• 16 Mb RAM . 
• 3.5 drive. 
• VGA, SVGA monitor. 
• USB port. 
• Serial Port RS 232 available. 
• Any Mouse and Printer compatible with the MS Windows™ 

operative system. 
• PC conform to European Directive 89/336 EMC 
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Technical features 

Flowmeter Bidirectional digital turbine 
Flow Range: 0.03 - 20 l/s 
Volume Range: 12 l 
Accuracy: ± 3% or 50 ml 
Resistance @12 l/s: < 0.7 cmH2O/l/sec 
Mouthpieces: Ø 31 and Ø22 mm 
Serial port: RS232C 
Dimensions: 150 x 45 x 53 mm 
Weight: 77g 
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Measured parameters 

FVC - Forced Vital Capacity 

Symbol UM Parameter 

FVC l Forced Expiratory Vital Capacity 
 

FEV1 l Forced Expiratory Volume in 1 sec 
 

FEV1/FVC% % FEV1 as a percentage of FVC 
 

PEF l/sec Peak Expiratory Flow 
 

FEV0.5 l Forced Expiratory Volume in 0.5 sec 
 

FEV6 l Forced Expiratory Volume in 6 sec 
 

FEV1/FEV6 % FEV1 as a percentage of FEV6 
 

FEV6/FVC% % FEV6 as a percentage of FVC 
 

Best FVC l Best Forced Expiratory Vital Capacity 
 

Best FEV1 l Best Forced Expiratory Volume in 1 sec 
 

Best PEF l/sec Best Peak Expiratory Flow 
 

Vmax25% l/sec Expiratory Flow @25% of the FVC 
 

Vmax50% l/sec Expiratory Flow @50% of the FVC 
 

Vmax75% l/sec Expiratory Flow @75% of the FVC 
 

FEF25-75% l/sec Mid-exp flow between 25-75%FVC 
 

FET100% sec Forced expiratory time 
 

FEV2 l Forced Expiratory Volume in 2 sec 
 

FEV3 l Forced Expiratory Volume in 3 sec 
 

FEV2/FVC% % FEV2 as a percentage of FVC 
 

FEV3/FVC% % FEV3 as a percentage of FVC 
 

FEV1/VC% % Tiffenau index 
 

FEF50-75% l/sec Mid-exp flow between 50-75%FVC 
 

FEF75-85% l/sec Mid-exp flow between 75-85%FVC 
 

FEF0.2-1.2% l/sec Mid-exp flow between 0.2 l - 1.2 l 
 

FiVC L Inspiratory Forced Vital Capacity 
 

FiF25-75% l/sec Forced mid-inspiratory flow 
 

FiV1 l/sec Forced Inspiratory Volume in 1 sec 
 

PIF l/sec Peak Inspiratory Flow 
 

VEXT ml Extrapolated Volume (back extrapolation) 
 

PEFT msec Time to PEF (10% - 90%) 
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VC/IVC - Slow Vital Capacity and Ventilatory pattern 

Symbol UM Parameter 

EVC l Expiratory Vital Capacity 
 

IVC l Inspiratory Vital Capacity 
 

ERV l Expiratory Reserve Volume 
 

IRV l Inspiratory Reserve Volume 
 

IC l Inspiratory Capacity 
 

VE l/min Expiratory Minute Ventilation 
 

Vt l Tidal Volume 
 

Rf 1/min Respiratory Frequency 
 

Ti sec Duration of Inspiration 
 

Te sec Duration of Expiration 
 

Ttot sec Duration of Total breathing cycle 
 

Ti/Ttot —- Ti/Ttot ratio 
 

Vt/ti l/sec Vt/ti ratio 

MVV - Maximum Voluntary Ventilation 

Symbol UM Parameter 

MVV l/min Maximum Voluntary Ventilation 
 

MVt l Tidal Volume (during MVV) 
 

MRf 1/min Maximum Respiratory frequency 
 

MVVt sec MVV duration time 

Bronchoprovocation Response 

Symbol UM Parameter 

FallFEV1 % Fall in FEV1 from baseline or post diluent 
 

FallVmax50% % Fall in Vmax50% from ref. 
 

P10 —- Provocative dose causing FEV1 to fall 10% 
 

P15 —- Provocative dose causing FEV1 to fall 15% 
 

P20 —- Provocative dose causing FEV1 to fall 20% 
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Prepare the microQuark 

Power supply is provided by PC through the keyboard/mouse 
PS2 plug. The unit is turned on/off automatically by the PC. 
1. Insert the turbine and be sure to push the turbine up to touch 

the end of the holder. 

 
2. Connect the microQuark to the PC, through the RS232 (data) 

and USB (power supply) port, as shown in the following 
picture. 
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Software installation 

Installing the software 
1. Select Run... from Windows Start menu. 
2. In the Command line box, type a:\install (assuming the disk 

is in drive A:). 
3. Click on OK (or press ENTER key). 
4. The program will load up a dialog box and ask for a 

directory where to be installed. 
5. The installation software will present a dialog box in which 

you have to select the device. Select microQuark. 

 
6. When the installation is over, the program will advise you 

with a message indicating that the installation has been 
successfully completed, click on End. 

Notice: The software is copy-protected. Install the software from 
the original disk. 

Run the software 
1. In the Windows Start menu, open the Program Group in 

which the software was installed. 
2. Click the Quark PFT icon. 

PC port configuration 
The first time the software is used, it is necessary to configure the 
communication port with the PC (USB, COM1, COM2,…). 
For further details, see the chapter Database management. 



 

28 - microQuark User Manual 

Software main features 

Display 
The program may contain several windows. The active window 
is highlighted with a different colour of the caption. Some 
functions of the program are "active window" sensitive (Print, 
right key of the mouse). 

Tool bar 
Many of the functions that may be selected from the menu can be 
activated more rapidly by clicking with the mouse on the 
corresponding icon in the tool bar. 
Positioning the mouse cursor on one of the buttons of the toolbar 
(if the option Hints is enabled), the description of the 
corresponding function is shown in a label. 

Show/hide the toolbar 

Select Toolbar from Options menu in order to show or hide the 
toolbar. 

Dialog windows 
The typical operating environment of Microsoft Windows is the 
Dialog box. This window is provided with a series of fields in 
which input the information. 

Use of the keyboard 

• To move the cursor among fields, press the Tab key until 
you reach the desired field. 

• Press the Enter key to confirm the information input on the 
dialog box or press the Esc key to cancel changes. 

Use of the mouse 

• To move the cursor among fields, move the mouse on the 
desired field and left-click. 

• Click on the OK button with the Left button of the mouse to 
confirm the information input on the dialog box or click on 
Cancel button to cancel changes. 
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Scroll bars 
Some windows are provided with scroll bars that help to see data 
exceeding the window space available. 
• To move the scroll bar row by row click the scroll arrows at 

the end of the scroll bars 
• To move the scroll bar page by page click on the grey area at 

both  sides of the scroll fields 

On-line help 
COSMED Help is a complete on-line reference tool that  you can 
use at any time. Help is especially useful when you need 
information quickly or when the user manual is not available. 
Help contains a description of each command and dialog  box, 
and explains many procedures for accomplishing common tasks. 
To get the Help on line, press the F1 key. 

Software version 
To know the software version and the serial number of the 
software, select About Quark PFT… from Help menu. 
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The calibration program 

Running the Calibration program 
Start the program and choose Calibration from the Test Menu. 
The software runs the Calibration software and the main menu 
changes accordingly. 

Log file 
The program creates and updates as default the calibration log 
file, containing the conditions and the results of all the 
calibrations performed by the user. 
To access the file select File/Report File... from the calibration 
program. 
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Turbine calibration 

microQuark is calibrated by COSMED. ATS recommends a daily 
calibration of the turbine. However if it is correctly maintained, 
turbine retains its precision for longer periods. We advice to 
calibrate the turbine daily to detect malfunctioning. 

Note: if you are using a slow PC, we recommend to set an higher 
refresh time. 
In order to calibrate the turbine: 
1. Connect the turbine flowmeter to the calibration syringe. 
2. Select Calibration from Test menu. 
3. Select Reference values from the Calibration menu and 

enter the syringe volume, if different to the displayed one. 
4. Select Turbine from the Calibration menu. 
5. When the Calibration Turbine dialog box appears with the 

syringe piston initially pushed all the way in, move the 
piston in and out for 5 inspiratory strokes and 5 expiratory 
strokes in order to get the first values appearing on the 
screen. Then move the syringe piston for other 10 strokes 
(IN and EX). 

6. At each of the 10 steps the software displays the results of 
the manoeuvre and the percentage error in the reading. 
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7. At the end of this operation, the software displays the new 
calibration factors. Press OK to store the new value. 

 
The 3 litres calibration syringe can be purchased directly from 
COSMED (P/N: C00600-01-11). 

Note: If a bacterial filter is used for the tests, do use it also 
during the turbine calibration. 
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Checking the system signals 

The control panel 
The Control Panel, which can be activated from the 
Calibration/Control panel… menu item, is a useful tool to 
check the main hardware functions of microQuark. 
By using the controls on Control Panel you are able to read the 
signals acquired by the system both as voltages and processed 
data. 

 

 Using the control panel

 

mV / real values 
display 

Select all 
channels 

Deselect all 
channels 

Signal refresh 
time 

edit parameters 
(name, unit,…) 
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Settings 

The software allows to configure some options selecting 
Configure from the Option  menu. 

 

Graphs 

All the graphs visualised and/or printed can be customised in 
colours and appearance. 
1. Select the desired colours of the curves (5 curves max can be 

overlapped on the same graph). 
2. Enable or disable the Grid option. 
3. Enable or disable the Show Info Test option. 

Serial port 

You must select the serial port RS 232 that will be used to 
connect the microQuark with the PC. 
To select the serial port, click on the proper COM button (the 
selected port must be different from the mouse one). 
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Units of measurements 

It is possible to configure the units of measurements, weight and 
height, for printing and viewing. 
To select the units of measurement click on cm/Kg or in/lb 
according to the desired format. 

Using extra fields  

The Patient’s database is organised in 3 different cards (Patient 
card, Visit Card and Test card.) where it is possible to store the 
information about patients and visits . 
Besides the standard information, it is possible to customise some 
fields (user free fields), entering and labelling measurements 
coming from other devices. 
The  customisable free fields are: 
• 3 fields in the Patient Card (Patient’s information) 
• 3 fields in the Visit Card (information about the visits) 
• 3 fields (2 numeric) in the Test card  information about Test) 

Customise the fields 

In the group User free fields type the desired text in the 9 fields 
available. 
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Patient's database 

The Patients database consists of a Patient Card, a Visit Card and 
a Test Card in which are listed all tests performed by the patient. 
Select Archive Navigator from the File menu  or press the 
button by side. 

 

Patient Card 

It collects all the information of a patient (first name, last name, 
date of birth) which remain the same for each visit. For each 
patient there is only one Patient Card, which is created the first 
time the Patient performs a test.  
To move within the database use the following buttons: 

 Move to the first patient in the archive 

 Move to the previous patient in the archive 

 Move to the next patient in the archive 

 Move to the last patient in the archive 

 Find a patient in the archive 

 Enter a new patient in the archive 

 Delete current patient from the archive 

 Edit the current patient card 

VVV 
Note: after having 
deleted a record 
(patient, visit or 
test), it is 
recommended to 
reorganize the 
archive in order to 
free disk space. 
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Visit Card 

It collects all information relative to the visit (diagnosis, visit 
description...) and to the patient information subject to change 
between one visit and another (height, weight, smoke). Each 
patient can be related to several Visit Cards provided they have 
been created in different days. Before carrying out any 
spirometric test it is necessary to create a new Visit Card or to 
open the today’s Visit Card.  
To move within the database use the following buttons: 

 Move to the first visit in the archive 

 Move to the previous visit in the archive 

 Move to the next visit in the archive 

 Move to the last visit in the archive 

 Find a visit in the archive 

 Enter a new visit card in the archive 

 Delete current visit card from the archive 

 Edit the current visit card 

Test Card 

It contains all the information about the test. 
To move within the database use the following buttons: 

 Delete current test from the archive. 

 Edit the current test 

Import/export a Tests card 
This function allows to import /export a test card with the 
respective visit and patient card. 
1. Select the patient. 
2. Choose the tests to be exported and press the key by side. All 

data will be imported/exported in the XPO file format 
(Cosmed proprietary). 

Diagnosis Database 
The program allows to manage a diagnosis database, whose 
records are composed by a diagnosis ID code and a string of text. 
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The report of the visits can be done either by typing the desired 
text in the field “Diagnosis” of the Visit Card or, more quickly, 
retrieving from the diagnosis database the desired one. 
If you want to insert, modify or delete a diagnosis from the 
database select Database Diagnosis... from the File menu. 
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Archive maintenance 

The software allows to manage files selecting Archive from the 
File menu. 
It is advisable to perform the archive reorganisation every month, 
in order to free space on the hard disk and/or to correct possible 
errors present within the database. 
It is possible also that your have no more hard disk space. So, 
you have to delete all the data. In this case, it is useful to perform 
the initialising. 

Reorganise the archive 
1. Select Reorganize archive from the File menu. 
2. Wait for the end of the operation before performing any 

other function. 

Delete the archive 
1. Select Initialize Archive from the File menu. 
2. Wait for the end of the operation before performing any 

other function. 

Backup and restore 
It is strongly recommended to backup files, a warning message 
will be displayed monthly. This function allows the user to 
restore the data if the PC or the HD will not work anymore. 

Backup 

1. Select Backup archive from the File menu. 

 
2. Selecting the destination path with the Browse key or press 

New to create a new directory. Press OK to confirm. 
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3. In the dialog box it will appear an estimate of the number of 
floppy you need in order to back up the archives. Press OK. 

Restore 

1. Select Restore archive from the File menu. 

 
2. On the Restore dialog box specify the drive source and press 

OK, a dialog box  will appear indicating all data of the 
backup processed. 

 
 
 
 
 
 



 

Spirometry 
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Setting spirometry options 

The software allows to configure some options selecting 
Configure from the Option  menu. 

Spirometry 

 

Automatic Interpretation 

microQuark has the function of interpreting each test performed 
by a patient visualising an automatic diagnosis. The algorithm 
has been calculated basing on “Lung Function Testing: selection 
of reference values and interpretative strategies, A.R.R.D. 144/ 
1991:1202-1218”. The automatic diagnosis is calculated at the 
end of the FVC if: 
• the automatic diagnosis option is enabled. 
• the patient’s anthropometric data allow the calculation of the 

LLN (Lower Limit of Normal range). 
• at least one FVC test has been performed. 
To enable/disable the automatic diagnosis: 
1. Click on Enable Automatic Interpretation. 
2. Select the LLN (Lower Limit of Normal Range) criteria 

among the ATS (LLN=Pred-0.674*SD), ERS (LLN=Pred-
1.647*SD) or 80%Pred (LLN=Pred*0.8) specifications. 
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Quality control 

microQuark allows a quality  test control. The calculation has 
been carried out referring to “Spirometry in the Lung Health 
Study: Methods and Quality Control, A.R.R.D. 1991; 143:1215-
1223”. The messages concerning the quality control are shown at 
the end of the test. 
To enable/disable the quality control, click on Enable Quality 
Control checkbox. 

Parameters manager 

 
The program allows to calculate a huge number of parameters; it 
is advisable, in order to simplify the analysis of the results, to 
view, to print and to sort the desired parameters only. Select the 
menu item Options/Parameters... 
View 
Move the parameters to view into the Selected parameters list. 
Print 
Move the parameters to print into the Selected parameters list. 
Sort 
Drag the parameter up or down with the mouse. 
Customise 
Add, modify and delete custom parameters. 
If it is necessary to restore the default parameters press the button 
in the left corner of the window to initialise the parameters 
database. 



 

48 - microQuark User Manual 

Predicted values manager 

 
The program contains a preset of predicted equations, but the 
user is allowed to customise its own predicted sets. Select 
Predicteds... from Options menu. 
The window is divided into two forms: Predicteds set and 
Formula definition. 

Predicteds set 

This form allows the user to manage the set of predicteds. The 
following information define a set: 
Name: identifies the set and cannot be duplicated; 
Description: free field; 
Age: the adult predicteds start since this age. 
To enter a new set of predicteds click on the New button. The 
field Name must be filled and must be unique. To stop without 
saving click on the Cancel button. To save the set, click on the 
Save button. 
To delete a set of predicteds click on the Delete button. If a set is 
deleted, also the associated formulae are deleted. 
It is possible to generate a new set of predicteds with the same 
attributes and the same formulae of the selected one. To do this 
click on the Copy... button and specify a new Name. 
To import a set of predicteds click on the Import... button and 
select a file of Predicteds files type. 
To export a set of predicteds click on the Export... button. 
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In the list Set current predicteds choose the current predicteds 
for printing and viewing. 

Set the current predicted 

microQuark  allows to calculate the predicted values according to 
the following configurable sets: 

Adults Paediatrics 

ERS 93 Zapletal 
Knudson83 Knudson83 
ITS white ITS white 
ITS black ITS black 
LAM LAM 
MC Barcelona MC Barcelona 
Nhanes III Nhanes III 
Select the desired choice in the group Predicted. 

Formula definition 

 
This form allows the user to manage the formulae associated to a 
set of predicteds. 
Select the set of predicteds from the list Predicteds set. 
To insert a new parameter click on the New... button. 
The parameter formulae can be: 
• calculated according to the predicteds in the list Use the 

predicteds formulae; 
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• customised by the user with the option ...or the customised 
formulae. 

The Delete button deletes the selected parameter. 
The Copy button stores the selected parameter in memory. 
The Paste button inserts a new parameter from the one copied. If 
the name is not unique, the user is asked whether to specify a 
new name or to replace the existing parameter. 

Page set-up 

 
Select Page Setup... from the File menu. 
Header All the printouts carried out by the 

program are preceded by 3 rows of 
customisable header (usually they contain 
the name and the address of the Hospital 
using the spirometer). 

Data Patient and visit information are printed 
below the header. These data are reported 
on 3 columns and 5 rows. the user may 
configure the disposition, change and 
eventually cancel the fields, as he prefers. 

Margins Configures the print margins from the 
borders of the paper. The unit of measure 
is decided in Units of measurements. 

Footer Configures information at the bottom of 
the page. 
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Printed file name Defines the automatic name to be 
asssigned to the pdf file, if the report will 
be printed in this format. 

 
 In the example it has been set to create a 

filename composed by <date of the test> 
followed by <last name> and <first 
name>. 
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Spirometry tests 

Once completed the phases of the introduction of the patient’s 
data and  the visit data, it is possible to carry out the spirometric 
tests. 
microQuark allows to perform the following tests: 

Key Test 

FVC pre Forced Vital Capacity 
 

FVC post Forced Vital Capacity after bronchial stimulation 
 

SVC Slow Vital Capacity 
 

MVV Maximum Voluntary Ventilation 
Before performing any test make sure that: 
1. microQuark is properly connected to your PC and the 

selected serial port (COM1, COM2) corresponds to the one 
effectively use. 

2. The name shown on the status bar corresponds to the patient 
who is to carrying out the tests. 

3. The today’s visit card exists. 

Recommendations for spirometry tests 
• The patient should wear the nose clips 
• The turbine has been recently calibrated (ATS recommends a 

daily calibration) 
• The paper mouthpiece or the antibacterial filter is properly 

connected to the flowmeter through the corresponding 
adapter 

For hygienic reasons, we strongly recommend the use of a 
bacterial filter. 
If a kid must perform the test it is recommended to enable the 
encouragement function which  shows exactly the manoeuvre of 
the FVC test. 

VVV 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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Forced Vital Capacity (pre) 

FVC is a reference test to verify obstructive (airflow limitations) 
and restrictive disorders (lung volume limitations). To achieve 
good test results it is fundamental a good manoeuvre (quality 
control messages, real time plots …) 
The main parameters measured during FVC tests are: 
FVC Forced Vital Capacity 
FEV1 Forced Expiratory Volume in 1 second 
FEV1/FVC% FEV1 as a percentage of FVC 
PEF Peak Expiratory Flow 
FEF25-75% Forced mid-Expiratory Flow 
The two representative plots are the Flow/Volume and 
Volume/Time loops. 
By comparing FVC, FEV1 and FEV1/FVC% values the software 
allows an automatic interpretation concerning the levels of 
obstructive and/or restrictive disorders. 

Perform a FVC (pre) test 
1. Select Forced Vital Capacity pre from the Test menu and 

wait for the green led is prompted on the right side of the 
screen. 

2. Explain the manoeuvre to the patient and press the F2 key.  
3. Wait some seconds and perform the test. 
4. After having performed the test, press F3 or wait for the 

automatic end (5 seconds without flow), so that the software 
displays the F/V and V/t graphs, the main parameters, and 
the predicteds values. 

5. In order to visualise the F/V and V/t graph and the main 
parameters press the following  buttons: 

 view Flow Volume graph 

 view Volume Time graph 

 view data of the test 
6. Press Alt+F3 to stop the acquisition discarding the results. 
7. Repeat the test until it is correctly performed (ATS 

recommends 3 times). 
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8. Press Exit to visualise the test list carried out during current 
session together with the results of the main parameters. 

9. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted as default) and press OK. 

Test encouragement 
During FVC manoeuvre you might experience some lack of 
collaboration with kids or with other patients. In this case you 
may find a good help in using the encouragement software tool. 

Perform the FVC test with the encouragement  

1. Select Encouragement from View menu. 
2. Perform the test as explained in the previous paragraph. 
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Slow Vital Capacity 

Important test for assessing COPD (chronic obstructive 
pulmonary disease) patients affected by this disease might 
present a the Slow Vital Capacity could be higher than the Forced 
one (FVC). 
The main parameters measured during SVC tests are: 
EVC Expiratory Slow Vital Capacity 
IVC Inspiratory Slow Vital Capacity 
ERV Expiratory Reserve Volume 
IRV Inspiratory Reserve Volume 
If the inspiratory/expiratory maximal manoeuvre is preceded by a 
some breaths at tidal volume the software allows to measure the 
Respiratory Pattern, represented by the following parameters: 
VE Ventilation per minute 
Vt Tidal volume 
Rf Respiratory frequency 
Ttot Breath time 
Ti/Ttot Inspiratory time/Ttot 
Vt/Ti Vt/Ti 

Perform a SVC test 
1. Select Slow Vital Capacity  from the Test menu and wait 

for the green led is prompted on the right side of the screen. 
2. Press F2 and instruct the Patient to breath normally until the 

message “carry out…” is prompted; then ask to perform a 
Slow Vital Capacity (deep inhalation, maximal slow 
expiration and deep inhalation again). 

3. Press F3 or wait for automatic interruption (5 seconds 
without flow) in order to visualise the V/t graph together 
with the main parameters compared to the predicted values 

4. To visualise the V/t graph and the main parameters press the 
follow buttons: 

 view Volume Time graph 

 view data of the test 
5. Press Alt+F3 to stop the acquisition discarding the results. 
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6. Repeat the test until it is correctly performed (ATS 
recommends 3 times). 

7. Press Exit to visualise the test list carried out during current 
session together with the results of the main parameters. 

8. Select the test that you want to save (the Best Test according 
to the ATS criteria is highlighted by default) and press OK. 

The reference for the ERV calculation is displayed on the V/T 
graph. 
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Maximum Voluntary Ventilation 

Test for assessing the maximum ventilatory capacity. In the past, 
it was commonly performed during routine PF tests, however its 
clinical use declined over the years. Today MVV test is most 
commonly performed as part of the exercise tolerance tests, 
where it is used as an index of maximum ventilatory capacity. 
Test consists in breathing in and out deeply and rapidly for 12, 15 
seconds. The expired volume during this short period is then 
extrapolated  
The most important measured parameter is the following: 
MVV Maximum Voluntary Ventilation 

Perform a MVV test 
1. Select Maximum Voluntary Ventilation  from the test 

menu and wait for the green led is prompted on the right side 
of the screen. 

2. Press F2 and make the Patient  breath as much deeply and 
rapidly as possible for at least 12 seconds. 

3. Press F3 or wait for automatic interruption (5 seconds 
without flow) in order to visualise the V/t graph together 
with the main parameters compared to the predicted values 

4. To visualise the V/t graph and the main parameters press the 
follow buttons: 

 view Volume Time graph 

 view data of the test 
5. Press Alt+F3 to stop the acquisition discarding the results. 
6. Repeat the test until it is correctly performed (ATS 

recommends 3 times). 
7. Press Exit to visualise the test list carried out during current 

session together with the results of the main parameters. 
8. Select the test that you want to save (the Best Test according 

to the ATS criteria is highlighted as default) and press OK. 
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Bronchial Provocation Test 

Bronchodilator test 
Bronchodilators are administered routinely in the PFT laboratory 
to determine whether airflow obstruction is reversible. 
Bronchodilators increase airway calibre by relaxing airway 
smooth muscle. 
The test consists of comparing results between the reference FVC 
(FVC PRE) and the FVC POST performed after the 
administration of the drug. Increasing value of 13-15% of FEV1, 
respect to the basal value (FVC Pre) is considered as a reversible 
condition. 
Main parameters are the following: 
DFEV1%pre Change of FEV1 as a percentage of test PRE 
DFVC%pre Change of FVC as a percentage of test PRE 
DPEF%pre Change of PEF as a percentage of test PRE 
Some authors states that the above mentioned parameters are too 
dependent from the FVC Pre, hence latest reference (ERS93, [A 
comparison of six different ways of expressing the 
bronchodilating response in asthma and COPD; reproducibility 
and dependence of pre bronchodilator FEV1: E. Dompeling, C.P. 
van Schayck et Al; ERJ 1992, 5, 975-981]) recommend the 
following parameters: 
DFEV1%pred Change of FVC as percentage of predicted value 
DFEV1%poss Change of FEV1 as percentage of possible value 

Methacholine and Histamine Bronchial provocation Tests 
The most common indication for performing methacholine and 
histamine bronchial challenges is to diagnose hyperresponsive 
airways. Some patients demonstrate normal baseline pulmonary 
function despite complaints of “tightness” wheezing, cough, and 
a little or not response to bronchodilator. Other patients 
demonstrate spirometric improvement after use of bronchodilator 
have diurnal variation in peak flows. In this groups aerosolised 
bronchial challenges are used to confirm a diagnosis of Asthma. 
We can summarise the use of the test as follows: 
1. Diagnose asthma 
2. Confirm a diagnosis of asthma 

VVV 
Note: Read 
carefully the 
contraindications 
in Chapter 1. 
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3. Document the severity of hyperresponsivness 
4. Follow changes in hyperresponsivness 
When patients with hyperresponsive airways inhale certain 
pharmacologic agents (i.e. Methacholine or histamine) the 
airways respond by constricting. 
Test consists of executing repeated FVC following the 
pharmacologic agents inhalation according to an established 
protocol. The fall of the FEV1 parameter is used to calculate the 
bronchial hyperresponsivness. The most important parameter is 
the PD20 that is amount of drug (mg/ml) that causes a reduction 
of 20% of the FEV1 respect the basal value (without drug). 
Main parameters are: 
P10 Dose that causes a 10% fall of FEV1. 
P15 Dose that causes a 15% fall of FEV1. 
P20 Dose that causes a 20% fall of FEV1. 
The representative plot is the Dose/response curve, showing the 
percentage variation of FEV1 versus the Drug dose in 
logarithmic scale. 
The program assumes as the baseline test the best FVC pre 
carried out during the today’s visit. You can change the reference 
pre test editing the Post test. 
The name of the drug, its quantity and its unit of measurement, 
can be typed immediately before any FVC post manoeuvre 
(manual protocol) or can be stored in a database of 
bronchoprovocation (File/Bronchial Provocation protocols 
Database…). 
 

Perform the test 
(During 1st step only) select Protocol... from the Test menu and 
choose the name of the bronchoprovocation protocol that you are 
going to use (manual protocol if you want to type the 
information about the agent before any manoeuvre)  
1. Select FVC post from the Test menu. 
2. Select an existing protocol or click on “manual protocol”, 

and wait the green leds turned on. 
3. Press F2, or the button by side, to start the test. 
4. Press F3, or the  button by side, to achieve the test. 
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5. In order to visualise the V/t graph and the main parameters 
press the follow buttons: 

 view Flow Volume graph 

 view data of the test 

 view bronchial provocation response 
6. Press Alt+F3 to stop the acquisition discarding the results. 
7. Repeat the test until it is correctly performed (ATS 

recommends 3 times). 
8. Press Exit to visualise the test list carried out during current 

session together with the results of the main parameters. 
9. Select the test that you want to save (the Best Test according 

to the ATS criteria is highlighted as default) and press OK. 

Bronchial Provocation protocols Database 
The response to a bronchoprovocator is usually assessed in terms 
of change in the FEV1, vital capacity or airways resistance on the 
basis of serial measurements (FVC manoeuvres) in which the 
results of the initial test constitute the reference values. The 
international literature proposes several standardised protocols in 
order to address the methodological issues of the various 
available techniques. 
The possibility to store a bronchoprovocation protocol in a 
database is useful to simplify and automate the sequence of 
operations that the Physician need to execute during the 
bronchoprovocation tests. 
The typical sequence of activities to carry out a 
bronchoprovocation test are: 
1. Typing and storing a bronchoprovocation protocol in the 

database (usually only once). 
2. Selection of protocol among the list of the ones already 

present in the database before carrying out the FVC post 
tests (the selection of “manual protocol” allows to execute 
the test fully manually). 

3. Performing the Post tests. 
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Enter a new Bronchial provocation protocol in the archive 

1. Select Bronchoprov. protocols database  from the File 
menu. 

2. Type the Protocol name, the Bronchoprovocator name and 
the unit of measurement in the proper input fields. 

3. If the bronchoprovocator has a cumulative effect select the 
cumulative check button. 

4. Enter the quantities for each step and press the button . 
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Viewing results 

All the visualisation functions refer to the test carried out by the 
Current Patient, whose name is indicated on the left-side of the 
status bar. 
To view tests results: 
1. Select  the Patients from the File menu 
2. Select the patient corresponding to the test you want to view. 
3. Select in the list box of the tests up to 5 tests of the kind 

(FVC, VC/IVC, or MVV) and press OK. 
To switch between graph and or data use the following buttons 
on the toolbar: 

 view  Flow Volume graph (F5) 

 view Volume Time graph (F6) 

 view data of the test (F7) 

 view bronchial provocation response. 
If you need more than one visualisation meantime use the New 
Window function from the Window menu. 
If you need to display a list of visits: 
• Select Visits list... from the File menu. 
• Type the name of the Company and/or the time interval 

desired or simply confirm for the complete list. 

Tests of the current patient 

If a current patient has been selected you can quickly view his 
tests selecting Test current patient... from the View menu. 

Delete a test 

1. Select Patients  from the File menu  or press the button by 
side. 

2. Select the test that you want to eliminate from the list of the 
tests referred to the Current Patient and press Delete. 
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Printing results 

You can print out in three different ways: 
• printing the Report 
• printing the Active Window 
• printing a series of reports 

Printing Reports 
To print a report of the current visit, select Print report… from 
File menu. The software will choose automatically the best 
performed test. 
The standard Report is composed by 1, 2 or 3 pages depending if 
you wish to printout the FVC data and the graphs together on the 
first page or if you wish to printout the bronchoprovocation 
response. 

 
• Selecting the option One page (no ATS) the report will 

contain, on one page, the F/V and V/t graphs of the best test, 
overlapped on the FVC Post, the patient data, the notes, the 
diagnosis and the test results. 

• Otherwise the report will contain two pages, the first with 
the patient data, the graphs and the diagnosis, and the second 
one with the measured parameters, according to the ATS 
recommendations. 

• The 3rd page will contain the bronchoprovocation response. 
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Select the desired options: 
FVC graph Prints the F/V and V/t curves for the best 

FVC test. 
One page (no ATS) Prints data and graphs on the first page. 
Response Prints the bronchoprovocator response. 
FVC post  Prints data and graphs for the Post FVC test 

(the test can be selected among the test 
performed in the current visit). 

Preview Views a report preview on the screen. 

Printing the active window 
This printout function is only enabled when the active window 
(title bar highlighted) is one of the following objects: 
• Any kind of Graph. 
• Numeric data 
• List of visit 
To print the active window select Print Active window from 
File menu. 

Printing a series of reports 
Sometimes it is useful to printout automatically a series of reports 
(all tests carried out with the employees, all tests carried out in 
the today's session). 
To print out proceed as follows: 
1. Select Visit List from the File menu 
2. Set the criteria of the visits to be added in the list (from, 

to,...) 
3. Select Print Report  from the File menu. 

Electronic reports (*.pdf) 
If an Adobe PDF writer “Printer Driver” is installed and set as 
the default printer, it is possible to store the printout report 
automatically in any location of the HD or eventually LAN paths 
according to a customizable filename format. 
It is possible to define the created filename format selecting 
File/Page Set up... (see Page set-up). 
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Export data 
With this function you can export the test data in 4 different 
formats: 
• *.txt (ASCII) 
• *.xls (Microsoft Excel) 
• *.wk1 (Lotus 123) 
• *.xpo (Cosmed) 

Export a test 

1. Select Export tests from the File menu. 
2. Select the test to export from the list box and press OK. 
3. Type the name and the format of the file in the dialog Save 

as. If  the ASCII format is selected, the Text button in the 
dialog box Save as allows you to configure the separators for 
character based files.  

 With the *.xpo Cosmed file format it is possible to import 
data from another Quark archive. Press OK to confirm. 

4. Select the folder for the export and type the file name. Press 
OK to confirm. A status bar will show the file creation. 
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System maintenance 

All service operations which are not specified in this user manual 
should be performed by qualified personnel in accordance with 
the service handbook (to be required to the manufacturer). 
All materials used in the construction of the microQuark are non 
toxic and pose no safety risk to the patient or operator. 
Prior to the device cleaning, disinfection and inspection it is 
necessary to switch off the device and to disconnect adapters 
from the supply mains. 
In order to guarantee the highest accuracy of measurements we 
recommend you to disinfect the turbine periodically. 

Cleaning and disinfection 
Cleaning and disinfecting instructions are of fundamental 
importance to control infections and assure patient safety. In fact 
aspiration of residue, particles and contaminated agents are life – 
threatening. 
In this handbook we strongly recommend you to follow the rules 
worked out by ATS and ERS (see: ”Lung Volume Equipment 
and Infection Control” – ERS/ATS WORKSHOP REPORT 
SERIES, European Respiratory Journal 1997; 10: 1928 – 1932), 
which are summarised and adapted for COSMED products as 
follows: 
• Accessible internal as well as external surfaces of equipment 

exposed to expired gas should be washed and disinfected 
prior to testing of subsequent patients. 

• Disinfecting should ideally be performed by heat 
sterilisation, but gas or liquid sterilisation can be used if the 
equipment is well cleaned first (no droplets of saliva/sputum 
remain). 

• Disposable gloves should be worn when handling 
mouthpieces, when cleaning equipment exposed to saliva or 
sputum and especially when drawing blood. 

• Laboratory staff should wash hands prior to testing of each 
patient. 

• Adopt particular precautions when testing patients with 
recognised high – risk communicable diseases (e.g. 
tuberculosis, multidrug – resistant staphylococcus). In these 
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cases, the clinical need for such testing should justify the 
risks. 

During the disinfection: 
• do not use alcohol or other liquids containing gluteraldehyde 

on the exterior surfaces of the equipment. Actually they can 
damage polycarbonates plastics and may produce unhealthy 
substances. 

• do not use abrasive powders or glass cleaners containing 
alcohol or ammonia on the plexiglas components of the 
equipment 

• do not steam autoclave any parts of the equipment unless it 
is clearly specified. 

• do not immerse the optoelectronic reader. 

Cleaning the turbine flowmeter 

It is necessary to disinfect periodically the turbine for sanitary 
measures or/and for the correct device function. 
As disinfecting solution it is suggested Sodium hypochlorite 5% 
(bleach). 
The disinfecting procedure is easy and may be effected every 
time the user needs, keeping attention to some precautions: 
1. Take out the turbine. 
2. Dip it in a disinfectant solution (non alcoholic based) for 

about 1 hour. 
3. Rinse the turbine in a vessel, filled of clean water, shaking 

gently to remove the disinfectant (do not clean the turbine by 
putting it under running water!). 

4. Let it dry to air. 
5. After cleaning the turbine, check if the turbine propeller 

rotates freely even with a low speed air flow. 
6. Connect the turbine to the reader. 

Precautions during the cleaning of the turbine 

1. Do not expose the turbine to high heat and do not put it 
under running water. 

2. Do not ever dip the optoelectronic reader in any kind of 
solution, the liquid infiltration would damage the internal 
circuit. 

3. Do not use alcoholic solutions to clean the turbine. 

VVV 
Warning: Do not 
use alcoholic 
solutions for the 
turbine, 
otherwise there 
can be damages 
to the plastic 
material. 
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Suggested disinfection solutions 

Helipur H Plus Braun Melsungen AG 
Gigasept FF Schulke & Mayr GmbH 
Dismozon pur Bode Chemie GmbH 
TETA-S Fresenius AG 
CIDEX Johnson & Johnson 

Inspections 
The equipment requires easy inspections to be carried out in 
order to assure a proper electrical and mechanical safety level in 
the years. 
These inspections are highly recommended after a rough use of 
the equipment or after a period of storage in unfavourable 
environmental conditions. 
Referring to the electrical safety, it is important to check the 
conditions of insulation materials of cables, plugs and any other 
visible part by means of simple inspection, when the equipment 
is switched off and adapters (or electrical feeders) are 
disconnected from the supply mains. 
Extract the turbine from the unit and verify, by inspection, that 
the turbine axis fits correctly its seats and the blade is strongly 
fastened on the axis itself (it can be useful to shake slightly the 
turbine in order to note any anomalous movement). 
Check if there are any torn or broken components in the 
breathing circuits: remember that they can create safety risk to 
patients during tests. 
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Service - Warranty 

Warranty and limitation of liability 
COSMED provides a one (1) year limited warranty from the date 
of the original sale of COSMED products. All COSMED 
products are guaranteed to be free from defect upon shipment. 
COSMED’s liability for products covered by this warranty is 
limited exclusively to replacement, repair, or issuance of a credit 
for the cost of a defective product, at the sole discretion of 
COSMED.  COSMED shall not be liable under the foregoing 
warranty unless (i) COSMED is promptly notified in writing by 
Buyer upon discovery of defect; (ii) the defective product is 
returned to COSMED, transportation charges prepaid by Buyer, 
(iii) the defective product is received by COSMED no later than 
four weeks after the last day of the one (1) year limited warranty 
period; and (iv) COSMED’s examination of the defective product 
establishes, to COSMED’s exclusive satisfaction, that such defect 
was not caused by misuse, neglect, improper installation, 
unauthorised repair or alteration, or accident.  If the product is 
manufactured by a third-party, COSMED shall make available 
for the Buyer’s benefit only those warranties which COSMED 
has received from the third-party manufacturer(s). COSMED 
hereby specifically disclaims any and all warranties and/or 
liabilities arising from defect(s) and/or damage(s) to and/or 
caused by products manufactured by third-party manufacturers.  
Buyer must obtain written authorisation from COSMED prior to 
the repair or alteration of COSMED products(s).  Failure of 
Buyer to obtain such written authorisation shall void this 
warranty. 
COSMED hereby specifically disclaims any and all other 
warranties of any kind, whether express or implied, in fact or by 
law, including, but without limitation, any and all warranties of 
merchantability and/or fitness for a particular purpose. 
COSMED shall not be liable for special, indirect and/or 
consequential damages, nor for damages of any kind arising from 
the use of any COSMED’s products, whether said products are 
used alone or in combination with other products or substances.  
Determination of the suitability of any of COSMED’s product(s) 
furnished hereunder for the use contemplated by Buyer is the sole 
risk and responsibility of Buyer, and COSMED has no 
responsibility in connection therewith. Buyer assumes all risks 



 

 Chapter 8 - Appendix - 73 

and liabilities for loss, damage or injury to persons or property of 
Buyer or others arising out of the use or possession of 
COSMED’s products. 
The limited warranty as herein above set forth shall not be 
enlarged, diminished, modified or affected by, and no obligation 
or liability shall arise or grow out of, the renderings of technical 
advice or service by COSMED, its agents or employees in 
connection with Buyer’s order or use of the product(s) furnished 
hereunder. 

Return goods policy for warranty or non warranty repair 
Goods shipped to COSMED for repair are subject to the 
following conditions: 
1. Goods may only be returned after your receipt of a Service 

Return Number (SRN) from COSMED S.r.l. 
2. Place your SRN report and Packing List outside the package. 
3. Goods returned must be shipped with freight and insurance 

charges prepaid. Collect shipments will not be accepted. 
4. The following list of goods are not eligible for return unless 

proven defective. 
- Special order items 
- Expendable products 
- Goods held over 30 days from COSMED’s invoice date. 
- Used goods not in original shipping containers. 
- Goods which have been altered or abused in any way. 

5. The following parts are not covered by warranty: 
- consumables 
- fragile glass or plastic parts 
- rechargeable batteries 
- damages due to use of the device not conforming to the 
indication reported in this manual  

Repair Service Policy 
Goods returned to seller for Non-Warranty repair will be subject 
to conditions 1, 2, 3, 4. 
The returned goods need to re-enter COSMED together with the 
customs documents (Pro-forma Invoice and Customs Paper) as 
requested by the Italian law. 
• The shipment has to be qualified as a Temporary Export. 
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• All the goods returned to COSMED without the customs 
papers will not be accepted. 

For European Community members: 
Pro-Forma invoice complete with: 
• Number 
• Description of the goods 
• Quantity 
• Serial Number 
• Value in € 
• Number of parcel 
• Gross weight 
• Net weight 
• Reason for resent (i.e. Resent for repair) 
In case you should send the system for repair please contact the 
nearest service centre or contact COSMED at the following 
address: 
COSMED S.r.l. 
Via dei Piani di Monte Savello 37 
P.O. Box 3 
00040 Pavona di Albano - Rome, Italy 
tel. +39 (06) 9315492 
fax +39 (06) 9314580 
E-mail: customersupport@cosmed.it 
For USA customers only please contact: 
COSMED USA Inc 
1808 North Halsted  Street 
Chicago, IL 60614 USA 
Phone:  +1 (312) 642-7222 
Fax:  +1 (312) 642 7212 
email: usa.sales@cosmed.it 
To ensure that you receive efficient technical assistance, please 
specify as precisely as possible the nature of the problem as it is 
specified on the assistance information form. 
We advise you to save the original packaging. You may need it in 
case to ship the unit to a technical assistance centre. 
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Privacy Information 

Dear Customer, 
we inform you that your personal data are gathered and will be 
used by Cosmed Srl in conformity with the requirements of the 
Italian privacy law (Decreto Legislativo 196/2003). We believe it 
is important for you to know how we treat your personal data. 

Personal data treatment and purposes 
We request and process your personal data: 
a. to place an order, register a product, request a service, 

answer a survey, enter a contest, correspond with us (all of 
the above, in the following: “service”) and, if necessary, to 
supply the Competent Authorities with the required 
information; 

b. in order to define your commercial profile; 
c. in order to use your commercial profile for own marketing 

and advertising purposes; 
d. for accounting purposes, including e-mailing of commercial 

invoices; 
e. for providing your information to selected business partners 

(also abroad), in order to supply the service; 

How your personal data are treated 
Your personal data will be stored in electronic format, and 
protected at the best from destruction, loss (even accidental), not 
authorized accesses, not allowed treatment or use not in 
conformity with the purposes above listed. 

The consent is optional, but… 
If you deny the consent, we regret we cannot supply the service. 

Holder of the treatment 
The holder of the treatment is Cosmed Srl, Via dei Piani di 
Monte Savello 37, Pavona di Albano Laziale (RM). The 
responsible of the personal data treatment is indicated in the 
documentation stored by Cosmed Srl itself. 
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Customer rights 
In accordance with art.7 of the Law, you can: 
a. obtain confirmation of the existence of your personal data 

and their communication in intelligible form; 
b. obtain: 

• updating, correction or integration of your data; 
• deletion or transformation in anonymous form of your 

personal data; 
c. deny your consent to the treatment of your personal data; 
These rights can be exercised directly requesting in writing to the 
holder of the treatment. 
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Converting factors configuration 

You can edit the parameters shown in Control Panel by selecting 
Control Panel from the Calibration menu in the calibration 
program, then pressing the button by side. 
You might configure the following options: 
Name: identify the parameter 
Unit of meas.: unit of measurement 
Base line and Gain: factors used to convert the acquired raw 

data (mV) into the final format according to 
Y=(mV-BL)*Gain. The value entered for 
gain must be multiplied by 1000 (for 
Gain=1, enter 1000). 

Precision: the number of decimals shown as 0 
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ATS 94 recommendations 

Reference: “Standardization of Spirometry: 1994 Update” 
“American J. Respiratory Critical Care Medicine”, Vol. 152, 
1107-1136; 1995. 

ATS recommendations 
Volume range: 8l (BTPS) 
Flow range: ±14 l/sec 
Volume accuracy: ±3% or < 50ml 
Flow accuracy: ±5% or < 200ml/sec 
Flowmeter resistance: <1.5 cmH2O da 0 a 14 l/sec 
Reproducibility: the 2 largest of 3 acceptable FEV1 and FVC 
values should be within 5% or 150 ml. 
The end of test: no change in volume for 1 second with at least 6 
seconds of collected volume. 
Accumulation time: the maximum time allowed for volume 
accumulation during the VC manoeuvre should be at least 30 
seconds and at least 15 seconds during the FVC. 
The spirometer should be store at least 8 FVC maneuvres. 
FEV1 should be calculated by using the “back extrapolation” 
method to detect the start of the test, extrapolated volume must 
not be higher then 5% FVC or 150ml. 
The graphic resolution of the printed report must be as in the 
following: 
Volume: 10 mm/l 
Flow: 5 mm/l/sec 
Time: 20 mm/sec 
F/V ratio: 2:1 
The total number of error (FVC e FEV1 >±3.5%, FEF25-75% 
>5.5%) during the measurement of the 24 standard  waveforms 
must be lower than 4. 
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Predicted values 

ERS93 

Reference Adult: 

Standardized Lung Function Testing: Official Statement of the 
European Respiratory Society, The European Respiratory Journal 
Volume 6, Supplement 16, March 1993. 

Reference Paediatric: 

Compilation of reference values for lung function measurements 
in children: Ph. H. Quanjer, J. Stocks, G.Polgar, M. Wise, J. 
Karlberg, G. Borsboom; ERJ 1989, 2, Supp.4,184s-261s. 

KNUDSON 83 

Reference Adult/ Paediatric: 

Changes in the Normal Maximal Expiratory Flow-Volume Curve 
with Growth and Anging: J. Knudson, D. Lebowitz, J. Holdberg, 
B. Burrows; ARRD 1983; 127:725-734 
Note: SD@FEV1/FVC e FEV1/VC da ERS93 

ITS (White race) 

Reference Adult/ Paediatric: 

Intermountain Thoracic Society: Clinical Pulmonary Function 
Testing, second edition (1984) pp 101, 144 
Note: SD@FEV1/FVC e FEV1/VC da ERS93 

ITS (Black race) 

Reference Adult/ Paediatric: 

Intermountain Thoracic Society: Clinical Pulmonary Function 
Testing, second edition (1984) pp 101, 144 
Note: SD@FEV1/FVC e FEV1/VC da ERS93 
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LAM 

Reference Adult/ Paediatric: 

A survey of ventilatory capacity in Chinese subjects in Hong 
Kong: Lam Kwok-Kwong, Pang Shing et Al. Annals of Human 
Biology, 1982, vol. 9, No. 5, 459-472. 
Note: SD@FEV1/FVC e FEV1/VC da ERS93 

Multicéntrico de Barcelona 

Reference Adult/ Paediatric: 

Spirometric reference values from a Mediterranean population: J. 
Roca, J. Sanchis, A. Agusti-Vidal, F. Segarra, D. Navajas. R. 
Rodriguez-Roisin, P. Casan, S. Sans. Bull. Eur. Physiopathol. 
Respir. 1986, 22, 217-224. 

NHANES III 

Reference Adult/ Paediatric: 

Spirometric reference values from a sample of the general US 
population: John L. Hankinson, John. R. Odencrantz and 
Kathleen B. Fedan. Am J Respir Critr Care Med 1999, 159, 
1798-187. 

Automatic diagnosis (algorithm) 
Reference: “Lung Function Testing: selection of reference 
values and interpretative strategies”, A.R.R.D., 144/ 1991:1202-
1218. 
LLN=Pred-0.674*SD (ATS, 50° percentile) 
LLN=Pred-1.647*SD (ERS, 95° percentile) 
LLN=Pred*0.8  (80%Pred) 

Message interpretation Criterion 

Normal Spirometry FVC and FEV1/FVC > LLN 
Obstructive abnormality 
(it may be physiological) % Pred FEV1 >= 100 
Obstructive abn.: mild % Pred FEV1 < 100 and >= 70 
Obstructive abn.: moderate % Pred FEV1 < 70 and >= 60 
Obstructive abn.: mod. severe % Pred FEV1 < 60 and >= 50 
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Obstructive abn.: severe % Pred FEV1 < 50 and >= 34 
Obstructive abn.: very severe % Pred FEV1 < 34 
Restrictive abn.: mild FVC<LLN and %Pred FVC>=70 
Restrictive abn.: moderate % Pred FVC < 70 and >= 60 
Restrictive abn.: mod. severe % Pred FVC < 60 and >= 50 
Restrictive abn.: severe % Pred FVC < 50 and >= 34 
Restrictive abn.: very severe % Pred FVC < 34 

Quality Control Messages 
Reference: Spirometry in the Lung Health Study: Methods and 
Quality Control, ARRD 1991; 143:1215-1223. 

Message Criterion 

Start faster VEXT >5% of the FVC and >150ml 
Blast out harder PEFT >120 msec 
Avoid coughing 50% drop in the flow in first second 
Blow out longer FET100% <6 sec. 
Blow out more air flow >0.2l/s within 20 ml of FVC 
Blow out harder dPEF<10% 
Take a deeper breath dFVC<200ml and 5% best FVC 
Blow out faster dFEV1<200ml and 5% FEV1 
That was a good test No errors 
FVC reproducible diff. 2 max FVC within 0.2 l 
FEV1 reproducible diff. 2 max FEV1 within 0.2 l 
PEF reproducible diff. 2 max PEF within 10 % 
MVV time too short MVV time less than 12 sec 
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